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How to use this Manual (this document is from an archived website)
We did not want to hold up the process of getting potentially invaluable Help resources made public until the time when a complete reference
manual could be published. The solution was to create a more or less ad hoc website where Help content could be made available
incrementally as needed. The result is a site where information is available in a real time fashion; however, it may be a bit disjointed for a while.
Admittedly, technical documentation tends to be late in coming with many projects of this nature, but with this site we are attempting to stay
ahead of the development curve, or at least keep pace with it.
Since there is an ad hoc nature to this site, it may be helpful to first understand how to go about finding the information. Resources at this site
can best be broken out into three general groupings: first, provide information about program installation and getting things configured correctly;
second; provide additional, more detailed information, about the many intricacies of the database and application; third, on a fairly quick
turnaround time, provide users of the program with errata, bugs, tips, and workaround solutions (until such time that a new version of the
program can be made available). In addition to the above groupings, there will be information located at this site that falls into a general FYI
category, e.g., background information about the database concept, pros and cons of different data management strategies, and basically
miscellaneous data management stuff that doesn't fit well elsewhere; that being said, the intention of this site is not to maintain overall project
level documentation, such as reports, data summaries, etc.
For the first grouping mentioned above, the ReadMe text file, packaged with the installation program, will be your best source of information.
The ReadMe file is also available under the 'Program Requirements and Installation' bullet located on the "Contents" page. This ReadMe file is
updated just before making a new Aquatic Surveys Program version available. It is specific to the version that it is being released, but may be
missing useful or vital bits of information, and that is where the third, above, grouping comes in to play -- we'll come back to the second
grouping later. So, to reiterate a bit, look to the ReadMe file documentation first. This should get you mostly there as far as setting up and
configuring the program. It is detailed, tedious documentation, but it does explain everything you need to know regarding installation and setup,
and may refer you to other documentation as well. If something is unclear in the ReadMe documentation, you can then look to information in
the second and third grouping.
The third grouping is information typically made available after a new version has been released so it is good to check online periodically for
new information or insights about the program, e.g., if there is a minor issue with the Aquatic Surveys Program, rather than releasing a whole
new version the fix or work around might be made available on the "Known Issues and Solutions" page, bullet-ed on the Help Contents page.
The second grouping is where to turn to after you have followed the ReadMe file instructions, i.e., the program has been successfully install,
configured, and you want to learn more about how to use it, e.g., importing and backing up your data, setting up a survey event, filtering data,
proofing your data based on built-in and custom data rules, etc.
Other than the almost separate ReadMe file documentation which pertains to the first grouping, the other two groupings and the miscellaneous
information are somewhat blended together by way of the bullet-ed items on the Help Contents page; however, Help items that pertain to the
third grouping will tend to settle out towards the bottom of the bullet-ed list of Contents items. We hope that in time this loose organization of
Help topics will begin to flow better and become almost reference manual-like, but until then please be patient, and look for the topic relevant to
your Help needs; if it's not there don't give up, because it's probably located elsewhere on the site.

Related Sites
•

CalFish -- California Coastal Monitoring

•

CDFW CMP Collaboration Portal (permissions required)

•

Field Data Collection Database Template Workgroup Site

•

Gradient and IP Event Modeling

Aquatic Surveys Program (ASP) Files
This section references ASP files that you will need to install and run the database application on your computer, including references to Help
documentation. Zipped files contain a "ReadMe" file with any necessary instructions for setting up data entry applications or running updates on
existing programs.
Files are compressed using the .zip file format. If you do not already have software for decompressing .zip files installed on your computer, a
free version of 7-Zip (compatible with Windows) can be obtained at http://www.7-zip.org. For CDFW Department Staff these files can be
accessed by way of Microsoft One Drive using your Department Office 365 account. If you are outside of the CDFW Department firewall then a
temporary FTP link can be provided. In either case, please contact Douglas Burch at the below email and address to get this setup.

Applications and Updates

•

"Pre-packaged" CMP Aquatic Survey Program Lookup Tables (308 KB) 7/21/2017
The file located at the above link contains lookup tables previously downloaded from the Survey Management Switchboard web
application; they have been compressed into a single file in .zip format; note that edits to these pre-packaged lookup tables are only
as current as the above date, i.e., the date and time when the *.xls files were originally downloaded and zipped; also, be aware that
this zip file does not include the "luContributor", "luLocation", and "luLocationLink" lookup tables; you will need to download these
three lookup tables, i.e., the Excel files, separately from the Survey Management Switchboard web application: the luContributor,
luLocation, and luLocationLink lookup tables are updated frequently so are not provided as part of the pre-packaged set. If you are
still using a version of the CMP Aquatic Survey Program (CMPASP) that was developed earlier than version 0.9 then be aware that
the Survey Management Switchboard online web application no longer provides lookup tables in a format suitable for using with these
earlier design specifications.

•

Aquatic Surveys Program (ASP) v0.9.16a for MS Access® 2007 through 2016 (3,643 KB) 1/6/2020
This is the current version of the ASP; it was developed for use with MS Access® 2016 and targeted for that version of MS Access®.
However, since MS Access® 2007 through 2016 uses the same database architecture, theoretically this version of the ASP should be
backward compatible with all versions of MS Access® going back to MS Access® 2007. This major¹ version, i.e., version 0.9.x, of the
ASP has a database design based on version 1.0.20130715 of the Field Data Collection Database Template². Changes reflected in
this major version, i.e., design of the tables, were implemented back in December of 2013, and despite significant minor version
changes since then if you have upgraded the program after December 2013 then you are still using the version 0.9.x tables. With this
minor version, i.e., going from version 0.9.7 to 0.9.8 (or later), you will have to upgrade from MS Access® 2002/XP to MS Access
2016. If you have not done so yet then first talk to your IT staff about upgrading to MS Access® 2016. Having MS Access® 2016
installed first is a critical step that needs to be taken before attempting to setup this version of the ASP. This version has many minor
tweaks and bug fixes, but the major enhancement has been to add the capability for working with imported .CSV (comma separated
value) files, particularly with those downloaded from the Pendragon Cloud ASP application. More details are provided in the setup
file’s "ReadMe" documentation and the instructions document contained within the below .zip file. For information about minor version
changes please see the "Known Issues and Solutions" page. For additional Help resources check out the "Aquatic Survey Program
Training -- Power Point Presentation" slides in the "Tools, Utilities, and Additional Training Materials" section below.

•

CMPAquaticSurveyUpdates_v0.9x.zip (231 KB) 10/29/2013
This utility packages "design update 0.9" which is required in order to make the previous CMP Aquatic Survey Program's back-end
database file, i.e., "CMP Aquatic Survey Data.mdb", operable with the version 0.9.x frontend data entry component of the program,
i.e., the "CMP Aquatic Survey Program.mdb" MS Access® database file. Back-end design updates through 0.6 will need to have been
applied to your CMP Aquatic Survey Data.mdb database file prior to the above utility being applied. To determine what updates have
already been applied to your back-end database file, at the program's startup screen click select "Data Name" from the "Program"
menu.

•

Aquatic Surveys Program Database -- Merged datasets and access to the data...

Tools, Utilities, and Additional Training Materials
Aquatic Surveys Program Training -- Power Point Presentations (16,577 KB) October 20, 2017
This is a six part presentation series that walks you through most of the process of setting up and using the CMP Aquatic Survey
Program (ASP), including a supplemental presentation on configuring and use of the Pendragon Cloud ASP application; it also
includes notes in addition to lots of screen shots.

ASP Database Append Queries (44 KB) July 20, 2017
Aquatic Survey Program Database Append Queries, including instructions for how to use them. These queries can be used to
merge data from the same survey which are maintained in separate ASP databases.
Aquatic Surveys Distribution Queries -- Version 2 (316 KB) February 6, 2015
This zip file includes example queries with an explanation of an appropriate process for using Aquatic Surveys data for deriving
species distribution coordinates from fish observation data where both specific and non-specific location information is available.
Also, the included documentation provides a background for the rationale behind using this approach.
CMP Analysis Queries (30 KB) March 14, 2014
This set of queries is used to generate flat tables that are needed for analysis of annual spawning survey data.
Instructions for Populating the luLocation Table and Creating Marker Records (89 KB) July 26, 2017
This zip file contains instructions, template tables, executable queries, and sample data; it can be used as a walk through for the
steps required to reformat reach attribute records, provided from a spatial sample-frame GIS layer, for population of the
luLocation lookup table with new reach records and creating "marker" locations (coordinate pairs, or xy locations, that demarcate
beginning and ending points along a stream).
Technical Notes for Creating a GIS Layer from Reach and Marker Locations (166 KB) May 27, 2016
This zip file contains instructions and sample SQL in text file format, and includes an example MS Access 2002 database
(contains example tables and template queries); this utility can be used as a walkthrough of the steps required for the purpose of
using the ESRI ArcGIS "Display Route Events..." utility to recreate the sample-frame GIS layer which can be used for your own
map development.

-¹ Major versions versus minor versions of an application: major versions have significant design changes and would be indicated
by a simple decimal numbering system, for example, version "1.1," where as a minor version would include the major version
numbering system plus an additional decimal and number to denote only slight changes to the application, perhaps a bug fix.
For example, version "1.1.3" would indicate a third slight modification to major version "1.1" which may or may not be noticeable
to the user.
² The Field Data Collection Database Template, a.k.a., FDC Database Template, is a model for relatively quickly generating field
data collection, project specific databases that use a design architecture based on collaborative efforts focused on developing
standardized data structures for managing raw Departmental data.
³ The "x" refers to anyone of a major version's minor updates of the program, e.g., 0.7.1 through 0.7.6.

Data Collection System Concept
For projects where data sharing and data merging are required, having a standard data structure is critical. Not having one
will likely result in the collection of data that is incompatible with data of similar efforts, limiting potential use of the data. One
of the goals is to be able to make inferences on population status and trends accross spatial and temporal aspects of the
data. Inherent in this goal is the need to standardize; (1) data collection protocol across different projects, (2) data structure
and definitions, (3) collection of geo-spatial attributes. In addition, a standardized data management system will save time by
facilitating the various steps in the data collection process, for example, planning, identification of data needs, data collection,
data entry, data compilation, data management, data delivery, data use, and data analysis.
We developed a database fit to the spawning survey protocols of Gallagher and Knektel (2005) and Gallagher et al
(AFS 2009) using a standard CDFW database template. The database is not, however, limited to only spawning survey
efforts of this type; it is flexible enough to handle most biological fisheries survey data in its current form, e.g. Weir data,
juvenile trapping or capture of all methods, where biological data are taken, and is easily adapted to additional data
requirements with new survey techniques. This effort began with the understanding that at some later date, management of
the data may be assigned to the CDFW Biogeographic Data Branch (BDB), now a group within the Department's IT Division.
Therefore, development of the Aquatic Surveys Program followed a well documented process using the Field Data Collection
Template concept, a product of BDB’s Data Collection Workgroup. Information on this conceptual approach can be found at
the following CDFW internal sites:

•
•

BDB Workgroup Intranet Site
CMP SharePoint Collaboration Site

o

Field Data Collection Database Template Development Site

We foresee this effort providing field staff, project leads, and data managers a useful tool for current programs, as well as it
providing a working example that can be learned from and used in the development of a statewide data management system
for the CMP and similar monitoring programs.
Pertinent Documents

•

•

Coastal Salmonid Monitoring Database Management: Report and Concept for Success (1,277 KB) January 29,
2015,
Burch, D., Gallagher, S. Ricker, S., and Bellmer, R. explain how the current database system works and the CMP
Technical Team's vision for future development of the database effort. This document targets a wide audience.
Coastal Salmonid Monitoring Database Management: Metadata and Protocol for the Aquatic Surveys Sampling-frame Attribute
Table (120 KB) March 31, 2015,
Dixon, D., Christy, T., and Burch, D. document protocols for populating the Aquatic Surveys Sampling-frame
attribute table. This document targets a wide audience but primarily defines the workload between the GIS Data
Manager and the Tabular Data Manager in regard to the Aquatic Surveys database and Sampling-frame.

Relevant Fisheries Data Management Articles

•
•
•
•
•

How to Manage Data to Enhance Their Potential for Synthesis, Preservation, Sharing, and Reuse—A Great Lakes
Case Study (467 KB) AFS: February 2013,
Kolb et. al. illustrate how thoughtful data management approaches can enhance and improve fisheries research.
An Evaluation of Data Entry Error and Proofing Methods for Fisheries Data (261 KB) AFS: May 2009,
Abstract.—Reducing data entry error has the potential to improve estimates produced by fisheries practitioners...
Stream Restoration Databases and Case Studies (361 KB) SER: June 2006,
Jenkinson et. al. provide background information on managing restoration data and list a wealth of references to
publicly available restoration databases.
Developing a Standardized Sampling Program (354 KB) AFS: July 2003,
Hayes et al. discuss the pros and cons of implementing standardized sampling strategies.
Standard Sampling of Inland Fish (883 KB) AFS: March 2002,
Bonar and Hubert provide an in-depth look at the benefits of standardizing fisheries data.

Program Requirements and Installation
For minimum requirements please visit the Download Page, and take a look at the ReadMe documentation that comes with
the most current version of the Aquatic Surveys Program. In short, for the XP operating system, MS Windows will have no
problem running the Access 2002 program. From Windows 7 on, the Access 2002 version gets buggier and buggier with
every update, and since Access 2002 is no longer supported by Microsoft, for future updates there is no concern by the
manufacturer whether their updates will break Access 2002 databases so it is important that you upgrade to Access 2010
(32-bit version -- the default) as soon as possible. You will also need MS Excel installed on the PC, and, for PDA deployment
only, Pendragon Forms installed (5.1 or Industrial version)

SurveyMgmt
The purpose of the "Survey Management," a.k.a., "SurveyMgmt," web application is to provide a central repository for
database lookup tables. More specifically, the lookup tables maintained by this online application must comply with the
latest Field Data Collection Database Template¹ standards.

•

To use this application a valid login and password are required to access the "Survey Management
Switchboard" page.

•

Select a lookup table from the dropdown list on this page then click the "Go" button.

•

This will take you to an online version of the lookup table where you can download the latest instance of the
table. Some tables will not have a download link, because they are only "supporting" lookup tables, i.e., they
are used to provide lookup list items for other lookup tables.

•

To edit the online lookup tables you will need additional permission, that is, be a member of the "Super User"
role. This will allow you to add items to the various lookup tables as well as add other "contributors."
Alternatively, if you have a large number of items to add then this could more easily be done by way of a
batch operation -- Contact one of the Survey Management administrators if you would like assistance with
this.

•

The tables can be downloaded in an MS Excel format or as an Adobe PDF document; typically, you will want
to download the tables as Excel files.

•

Lookup table pages will have links to additional Help information, e.g., the "luSpecies" table has a Help page
regarding how to find the correct species codes.

Go to the Survey Management Switchboard

Important Changes
As of September 3, 2015 the Survey Management Switchboard web application has been migrated from a CDFW
Regional web server to a Departmental server, now maintained within the Department's Data Technology Division. For
the most part the application behaves as it did before, however a few changes are evident.
Logins are now authenticated through our CDFW online registration system. If you are currently a CDFW staff member
then simply use the same login and password used when log-ing into your office computer. If you are not CDFW
Department staff, and you have not already setup a login with our Department, then please register in order to create
an account at the following link:
https://nrm.dfg.ca.gov/myaccount/register.aspx
After an account has been setup then you will need one of the Survey Management administrators to grant the
appropriate permissions before access to this web application is possible.
The other major difference with the post-migration application is that the download/export lookup table records page
may look a little different, and the download format is now in the newer version of MS Excel, i.e., .xlsx files. The
ReadMe documentation that comes with the latest version of the desktop data entry application, available at the
Download Page, explains how to use the .xlsx lookup table files with the MS Access 2002 version of the desktop data
entry Program. If you are using the latest version of the desktop data entry program, and have used the Conversion
to MS Access 2010 instructions that come with the program files, provided at the Download Page, then the
downloaded .xlsx lookup table files will work as is.
Basically, if you are still using MS Access 2002 then you must open each of the .xlsx lookup table files in MS Excel
2010, or later, and save them as .xls files (97-2003 format).
Other than that, the migration changes are minor, like validation messages when adding/editing lookup table records
will appear a bit different.

¹ The Field Data Collection DatabaseTemplate, a.k.a., FDC Database Template, is a model for relatively quickly generating field data collection, project
specific databases that use a design architecture based on collaborative efforts focused on developing standardized data structures for managing raw
Departmental data.

Adding New Projects
Before you can begin using the Aquatic Surveys Program, as well as download and import the current lookup tables, a new
project will first need to be created. Think of the project as the highest level of organization to your data, e.g., the new project
might be named "Coastal Salmonid Monitoring Plan (CMP): Smith River" and consist of multiple years of spawning surveys,
juvenile surveys, and life cycle monitoring data.
Go to the ‘Help’ tab at the top of the screen and select "Go to Survey Management Switchboard". This is a hyperlink that will
take you to the "Survey Management" web application where all of the current lookup tables are managed.

You will need a login and password to access the tables. Contact Technical Support to get step setup. Once you are logged
in select the "luProject" lookup list. Enter a new "ProjID" number and text name or brief "Description" which is descriptive of
the project.

Click on the "View/download all Records in report format". In the "Select a format" dropdown, select "Excel", then click on

‘Export’. On the "File Download" dialog screen click "Save". Save the file to the "...\Aquatic Surveys Program" folder. If you
are asked if you would like to replace an existing file of the same name, click "Yes".

Adding New Survey Extents
Once a new project has been created, the next few steps geographically define the study area. The first spatial definition is
the survey extent. This should be thought of as the entire area covered by any individual survey (See "Setting Up a new
Survey" in the CMP Aquatic Survey Program.). In our Smith River "Project", we may have a juvenile survey that is composed
of an area that is a subset of the area within the Smith River. The "survey extent" is the entire area that is covered by a
particular survey. There may be different survey extents for adult spawner surveys within the Smith River project. To enter a
new survey extent:

•

In the "Survey Management Switchboard", select "luLocation". Scroll to the bottom of the table. At the bottom of the
table you will find blank cells to enter your new record. Select the "ProjID" item from the drop down list, and select
the "ProjID" number you entered in previously.

•

In the "LocationType" field, select the type of survey extent that reflects your survey. For example, a spawning
survey may cover a number of GeoUnits (streams in this case), and constitute a stream "reach group" location
type. Remember, we are setting up the geographic extent for the entire survey. A trap or weir that has one location
would constitute a "coordinate" location type.

•

Enter a text "Description" of the survey. This description can be up to 255 characters in length.

•

Enter a "LocationCode" as a reference to this survey extent, e.g., "FWC" is used as a code for the survey extent of
Freshwater Creek. The "LocationCode" field allows up top to 10 characters in length, and can be anything that is
meaningful to you in describing your entire survey extent, yet keep it succinct.

•

Check the "IsSurveyExtent" box in the next field. Select the appropriate "GeoArea". A "GeoUnit" value is not really
necessary to define a survey location as there will likely be multiple GeoUnit values, e.g., all streams reaches that
comprise the survey extent.

•

In this case the "GeoUnitID" is the unique GeoUnit identifier from a GIS hydrography layer, e.g., a unique stream
identifier or "CDFW Water ID". A GeoUnitID would only be used, but again is not necessary, if the survey extent
included only one GeoUnitID, for example the entire survey extent consisted of the stream's mainstem. If it is the
case that a single GeoUnit fits your survey extent then you may include the GeoUnit, GeoUnitID, and enter the
distance along the hydrography that identifies the down stream starting point of your survey extent in the
"BegGeoUnitMeas" field, and the end point in "EndGeoUnitMeas" field, then the units of measurements in the
"GeoMeasUnits" field. If your survey extent is simply an XY coordinate, e.g., a fixed trap location, enter the XCoord
and YCoord values, provide the coordinate system from the "CoordSys" drop down list. If your survey extent has an
up GeoUnit and down GeoUnit or up GeoUnit identifier, e.g. Quarry Rd. Bridge, enter this as a globally unique
identifier (derived from the LocationID for the Quarry Rd. Bridge's coordinate location) the "DnLocationID" and
"UpLocationID" fields; however, this step is optional. Next, select the "GISLayer" that you used to define the
hydrography, or geo-referencing GIS layer being used, e.g., "FRAP_Hydro24K_LLID", etc.

•

Enter any survey extent related specific notes in the "Notes" field. Now, you have just defined the entire space that
encompasses all sites, reaches, point locations, etc., of your survey.

Adding New Locations
Within each survey extent, are survey locations, i.e., location entities represented by identifiers or codes. These might be
reaches of stream reach group, point locations, or two dimensional polygons. Locations are where that sampling takes place
within the survey extent for a given survey (See "Setting Up a new Survey" in the CMP Aquatic Survey Program, however
continue along with the Help documentation if you are a first time user.). This series of steps are used to add survey
locations within the survey extent you just entered.

•

If you have identified sampling sites (e.g., coordinates, reaches, lines, polygons) within the survey extent you just
defined, you will then define these sampling areas in using the same process described above, BUT leave the
"IsSurveyExtent" box unchecked.

•

Repeat this step for all sampling locations within the survey extent.

•

Repeat the previously described step to export the "luLocation" table.

Adding New Contributors
For the purpose of this database model, contributors are those involved with the project, for example, this could include any
of the following persons:

•

A field person collecting the data

•

The person appending data from the PDA device to the desktop database.

•

Anyone with permissions to access, view, or edit the data

The provided contributor information allows us to both know something about the people invovled with the data as well as to
help maintain a level of security regarding access and editing of the lookup tables.
Most of the fields in the "luContributor" table are optional; however, 'Contributor' and "Login" values are required, and they
must be unique within the entire table. The login value can be up to 30 characters long and must not contain spaces. The
contributor value can be up to 50 characters long and permits spaces as long as they do not start or trail the text string.
Additionally, first name and last name are required, and contact information, such as an email or phone number, is
encouraged.
The difference between a Contributor and a Login is minor. The Contributor value simply allows some extra flexibility when
creating a moniker to reference an individual, for example, a Login might be "JDoe" while the Contributor value could be
"John Doe", or "Johnny" for that matter. Typically, the Contributor and Login values would be the same in order to keep
things as simple as possible, and should follow the format "JDoe" for John Doe. Since both Contributor and Login values
must be unique within the entire luContributor lookup table, this might necessitate creativity when assigning logins and
contributor names, like including the middle initial if a value has already been used, or adding on a "Jr" if John Doe's son
works on the project and has the same name, for example, "JDoeJr". The other difference between the Contributor value and
the Login is that the Login value is used when logging into the Survey Management application while the Contributor value is
used as a short handle reference to the ContributorID.
Only individuals with "SuperUser" or "Admin" designations, that is, the box is checked for those roles, can add new
contributors to the luContributor table. Only those in the Admin role can actually see the passwords so if a super user adds a
contributor to the luContributor table then a request to an administrator for the automatically assigned password must be
made by phone or email. An administrator can also setup contributors with specific passwords if requested, and contributors
can change their own password.
This series of steps lead you through entering new contributors:

•

Go to the "Help" tab at the top of the screen and select "Go to Survey Management Switchboard". This is a
hyperlink that will take you to the "Survey Management" web application where all the current lookup tables are
managed.

•

Select the luContributor table from the drop down list.

•

Scroll down to the bottom of the luContributor table and find the empty cells to enter the required "Contributor" and
"Login" information. Save the luContributor table with the same process by clicking on the "Add" text link.

Updating the Aquatic Surveys Program with New Lookup Tables
Once you have added records to any of the lookup tables using the online "Survey Management Switchboard", you will need to
update the program from these updated online tables.

•

Open the Aquatic Surveys Program.

•

At the startup form click on the "Options" menu on the left side of the menu bar then click on the "Import Lookups" menu item.

•

At the "Import Lookups" dialog box you will see an option button list of possible lookup tables that can be imported to the program.

•

First select "luClipMark" option then click "OK" button.

•

The program automatically updates your local luClipMark lookup table with information from the imported luClipMark.xls you
downloaded from the "Suvey Management Switchboard".

•

Repeat this step for the remaining downloadable tables, e.g., "luContributor", "luCoordSys", etc.

•

If for some reason there are items in one your local lookup tables not in the master lookup table that you downloaded from the Survey
Management Switchboard, then you will be prompted with a warning message like the one below.

•

To see what these "rouge" items are click on the button next to the "View rouge lookup records" text.

•

You may be able to recognize these lookup table records as items not related, or not critical, to your project...If that is the case then
the import process can be attempted again and the warning ignored or turned off. If you believe that you have data referencing these
items then you will have to do a little research and figure out which of your data references the rouge lookups and fix the problem.*

•

If you would like to go ahead with the update and ignore the warning then return to the "Import Lookups" dialog box and check the box
that says "Ignore warning message...", and then click on the "OK" button again.

•

If you would like to resolve your "Rouge" lookup item issues then here are some tips:
o The following lookup tables have referential integrity with your data...meaning that if you ignore the warnings then data
associated with rouge values in any of the below lookup tables will be deleted!
▪ luClipMark
▪ luLengthRange
▪ luLocation
▪ luMethod
▪ luObsEven
▪ tluProject
▪ luPunch
▪ luReddAge
▪ luSpecies
▪ luStrHabType
▪ luSurveyType
▪ luTagColor
▪ luTagType
▪ luUnit
▪ luWeather
o The following lookup table has referential integrity as well; however, in its case if you ignore the warning it will not delete
data but will replace, or reassociate, an "Anonomous" for actual surveyors names if any of those surveyors names are in the
list of rouge values.
▪ luContributor
o The following lookup tables have NO referential integrety so for these you can ignore the warning message without having to
worry about any loss of data.
▪ luCoordSys
▪ luLocationLink
▪ luReachLifeStage

▪
▪

luReachSchedule
luStageluStatus

*If you are getting the warning messages, and after reading the above, and you are either unsure of how to remedy the rouge
lookup table values or you still have concerns regarding the potential loss of your data should you proceed then
contact Technical Support.

Naming the Data and Setting the Project ID
After all of the lookup tables have been imported, and before doing anything else, you will need to give the data in your [backend] local database, i.e., the "Aquatic Surveys Data.mdb" file, a unique name, preferably something that is meaningful to you
and others. Next, you'll need to set the relevant project ID value for your local database.

Name Your Data
Even though you may view and edit the data in the frontend database, i.e., the "Aquatic Surveys Program.mdb", the data
actually resides in the back-end, and by simply swapping out the back-end database, with different databases but having the
same file name, we can view and edit multiple databases through the frontend. So, to quickly recognize the data in a back-end
database, a unique name should be applied to it. We provide or edit this information in the frontend's "Data Name" form. The
information that we provide is stored in the back-end database's "Version" table.
The naming convention does not have to be anything fancy; it just needs to be able to help us make a distinction between one
database and another. For example, the name of the data could be "JDoe's 2010-2013 Spawner-survey Data," or simply "JDoe's
Archived Project Data." The idea behind this exercise is that someone could simply look in the Version table of a back-end
Aquatic Surveys Program database and distinguish between one dataset and another, i.e., without digging through the data
tables and comparing dates; we might think of this "Data Name" value as very course, high-level metadata.
To provide a data name, at the Aquatic Surveys Program's startup form, select "Data Name" from the "Program" menu.

By default, with a new Aquatic Surveys Program back-end database, the "Data" field will say "New Database". Change this text
to whatever is appropriate for your given dataset.

Additionally, you will notice a text box labeled "Max. Date". This field will automatically update when the back-end database is
edited -- You can also edit this field manually. The "Project" field is for maintaining the unique numeric project identifier for your
data (see the section on "Adding New Projects"). The "Updates" field maintains the current design version number of your backend database; if this number does not match the front-end's major version number then the two databases will not link.

Set the Project ID
In order to begin using a new database you will have to set the value in the text box labeled "Project", i.e., select the appropriate
project from the drop down list (If your project does not appear in the list then refer to the section on "Adding New Projects".).

Setting up a Survey Default
Default settings allow the user to make certain fields auto-populate with values that are consistently used for an entire survey. For example, if
the survey uses only one sampling method then the user may want to populate the "MethodCode" field with one single value for each sampling
event. Similarly, if temperature data is ALWAYS taken in Centigrade the user may want to default this field as well. The default settings will
also be used to customize your data entry forms to your data collection (i.e., just the fields you will be populating with survey data) and ease the
entry process described later. The new database comes with only one configuration for auto-populating, i.e., the 'Standard' default settings;
however, you may want to configure some default settings specific to your project, e.g., measurement units to use, fields to hide, etc.

•

Click the "Options" tab on the program’s task bar.

•

Select "Defaults" to choose your survey’s default settings.

•

If the standard defaults fit your needs you are welcome to use these settings.

•

However, It is more than likely that you will want to choose your own survey specific values for the default fields.

•

If the standard default settings do not fit your data collection, find the radio arrow buttons at the bottom of the "Defaults" dialog box,
and click the right-most "arrow" button. This brings you to a new blank Defaults entry screen.

•

In the top "ID" field enter a short test description that describes the defaults that your survey will use, e.g., "Freshwater Creek Weir
Trapping", etc.

•

Continue down through each displayed field, selecing the appropriate values you want as the default value. The database will autopopulate each record with these default values, without the need to manually enter these data.

•

Click the "Hide" checkbox if you prefer not to see these fields in the data entry forms. Remember, these values will still be populated
in the database, but you defaulted these so by checking the "Hide" box you are simplifying the data entry forms. If you are not
selecting a default value for these fields and need to have these data collected then DO NOT check the Hide button, i.e., you want the
contributor to manually select a value during data entry.

Setting-up a New Survey in the Aquatic Surveys Program
•

If you have completed all the steps to this point, you are ready to enter a new survey within the Aquatic Surveys Program.

•

Open the Aquatic Surveys Program.

•

Project leads should select themselves as the contributor by clicking the dropdown carrot.

•

At this point you may leave "Standard" in the "Defaults" box.

•

Click the "Enter" button.

•

For the time being ignore the "Select", "Detail", and "Data" buttons. We will use these later.

•

Click the ‘ID’ button in the ‘SurveyID’ blank cell.

•

This will auto-generate a SurveyID code consisting of the first three letters of the contributor (project lead) followed by
MMDDYYHHMMSS time. This will be the unique identifier for the survey.

•

Click the dropdown carrot in the LocationID cell and select the LocationID referencing the location description you entered in the
luLocation table as the survey extent.

•

Click the calendar button in the "StartDate" field.

•

Navigate to the start date of your survey.

•

Repeat this for the last date of your survey.

•

These dates bound the period that all data taken on a given survey will occur.

•

Enter a brief "Description" of the survey.

•

Click the "Select" button to highlight the survey record in green.

•

Click the "Detail" button. Add any comments in the text field provided. This is meta-data information that will describe what the survey
is for, intricacies of the methodology used, etc.

•

At the bottom of the screen you will find two boxes. The red carrot and ‘x’ is used to delete the survey
record AND ALL ASSOCIATED RECORDS. If you click this button, you will loose any data that might have been entered. You will
be prompted with this message. PLEASE READ this message and know what you about to do if you accept. The "Door" icon button
simply exits you from this entry screen and returns you to the previous form.

Customizing the Data Entry Screen within the Defaults Settings
Your survey may not be interested in taking data for all fields in the data tables. You can customize the appearance of the
data entry forms using the defaults settings.
Within the Defaults settings dialog click on the carrot dropdown in the Subform: field. Select the table you want to customize
from either the "Individual", "Count", or "Redd" tables.
Click the "Subform Fields to Hide" button. This opens a blank table with a "Subform" field and a "HiddenField".
Click your cursor into the top most "Subform" field cell then click the dropdown carrot in the "Subform" field and select one of
the available subforms.
Click your cursor into the adjacent HiddenField cell then select the field within the subform you would like to hide in the data
entry screen.
Repeat the last two steps for each subform field you would like to hide in the data entry form. This single table is used for
fields you would like to hide in any subforms that have a datasheet view, e.g., "Individual", "Count", "FishOnRedd".
See figure below for an example of how this table might look when filled out. Note that more than one subform can be

chosen, e.g., "Individual", "FishOnRedd", "Count", etc., and more than one field within each of those subforms, e.g., "RecID",
"LengthType", "WeightUnits", etc., can be hidden by populating this default table.

Congratulations! You are ready to enter data into the Aquatic Surveys Program.

Setup Instructions for the Pendragon Forms Cloud Application

As of version 0.9.8 the Aquatic Surveys Program supports use of the newest platform for Pendragon forms which makes use of
Cloud technologies. The Pendragon Cloud platform in many ways works like the Pendragon PDA software (addressed in a
separate section), and in some respects the procedure for setting-up this mobile field data collection application has been
greatly simplified when compared to the PDA version, but a few of the procedures are much different and can result in confusion
and problems if the instructions are not followed carefully!
There are some things to know upfront before going down this route:

•

The Cloud platform works by way of Smartdevice mobile technologies. There is both an iOS and Android app, as well
as a version that works in the iOS Safari browser. At this time CDFW staff may only purchase and use iOS devices
(iPhones and iPads). For those using iOS devices you will want to use either a model 5 or later iPhone or a model 4 or
later iPad. If you decide to go with an iPad we have found during testing that the iPad-mini works best. After equipping
these devices with a waterproof case (highly recommended) the mini is still manageable in the field as far as weight and
bulkiness. Additionally, going with the iPad you make sure that the device is cellular capable, however you do not need
a cellular service subscription (not activated). By having your device cellular capable you will be able to use the iPad as
a GPS device, i.e., the cellular antenna is also an integrated GPS receiver that works regardless of whether you have
cellular services enabled or not.

•

The other significant difference between the Cloud versus PDA platform is that you will need a Pendragon Cloud
account where as with the PDA software it was a one time license purchase. With a Pendragon Cloud account comes a
set number of "user seats." User seats refer to the number of unique devices that can login into the account, i.e., the
device is the "user" and not the actual number of unique individuals using that device. The Aquatic Surveys Database is
based upon distinct projects, all contributing towards an overarching program like anadromous species "Coastal
Monitoring." Since with this distributed model projects maintain their data separately, at least during the field season,
there will arise some issues with sharing an account across projects. Some strategies for dealing with potential data
conflicts are addressed and outlined in the following document that comes with the current Aquatic Surveys Program
setup files (available on the "Download" page). That document is listed below:

"Setting-up and using the Pendragon Cloud Version with a Shared Account.pdf" included with the above mentioned setup files.

For instructional information regarding how to setup and use the ASP Pendragon Cloud app there are two resources that will
provide you will quite a bit of detailed information in addition to what has been provided here:
1) The ReadMe file that comes with the setup files has a section titled "INSTRUCTIONS FOR SETUP OF THE PENDRAGONFORMS®
CLOUD APPLICATION"

2) and, on the Download page you can also find step-by-step instructions and screen shots from the Part VI Power Point Training Slides with
link titled "Aquatic Surveys Program Training -- Power Point Presentations".

Extract and Rename the Pendragon CSV Files
File Extracting and Renaming Prep for the ASP...
Getting your data out of Pendragon's Cloud requires you to download data for each table...one at a time. This is somewhat of a
grind when compared to the import method used by the PDA application so be prepared for multiple steps in order to accomplish
this.
...as you download the .csv data files simply rename the zip files adding a 1, 2, 3,etc., for example, from formdata.zip to
formdata(1).zip...the next one would be renamed to formdata(2).zip; it really doesn't mater what you rename the formdata.zip
files to as long as each file has a unique name and all .csv files are placed in a single folder.

Download and uniquely name .zip files.
In addition, the files will need some preparation, because they are downloaded as separate .csv files in compressed, or .zip file,
format.

Each .csv file is packaged in the downloaded .zip file.
One method of dealing with this is to meticulously extract the files and rename them...doing this multiple times. An alternative
that can save you some time is to use the file extraction and renaming tool; this menu item can be found at Add-ins --> Options -> "Extract and Rename the Pendragon .CSV Files"...which is available when at the "Import Data: PRE-APPEND..." table view
screen.

Click on the "Extract and Rename the Pendragon .CSV Files" menu item.
The menu item will bring up an "Extract and rename Pendragon CSV files from what folder?" dialog box...Once you have
provided the dialog box with the folder location of the .zip files and clicked "OK" the ASP utility will extract the files into a timestamped sub-folder, move them to the ASP "ImportFiles" subfolder, and rename them to their meaningful and appropriate
names, e.g., "ClipMark.csv", "Count.csv", etc.
You'll also have to configure the "PendragonForms" table with the appropriate "form name to form ID combinations." Access this
table view by way of the Add-ins --> Options --> "Configure Pendragon Forms Identifiers" custom menu item -- be extra careful!
It is critical that you get these form identifier to form name combinations perfect.

Click on the "Configure Pendragon Forms Identifiers" menu item.

If you have recreated any of these tables then form identifiers will have changed and these changes must be reflected in the
PendragonForms table.

Setup Instructions for the Pendragon Forms PDA Application
If you have the Aquatic Surveys Program installed and working properly then you have met the minimum system requirements for running the
Pendragon Forms® 5.1 ("Industrial" version) PDA application as well. The following is additional software that will need to be installed on your
computer. We highly recommend the ruggedized, field appropriate Meazura PDA available from Portable Technology Solutions, manufactured
by Aceeca, and a licensed installation of Pendragon Forms® 5.1 software, available from the Pendragon Software Corporation.

Importing *.pff forms and *.csv files into Pendragon Forms Manager
The Pendragon Forms® Manager application will need both the *.pff and *.csv files imported; follow the instructions in your Pendragon Forms
documentation for importing from .pff and .csv files. Be aware that in this version of the Aquatic Surveys Program the exported .csv files will
contain the information necessary to appropriately check the Pendragon Forms® lookup list check boxes, i.e., "Available", "Stored Values", and
"Sorted" so you no longer need to do this manually. Also, on this subject, when importing the .csv files into Pendragon Forms® Manager, you
must name them exactly as the file is named, minus the extension. In other words, if the file is named "luClipMark.csv" then you would name
the lookup list "luClipMark".

Exporting to Comma Separated Lookup List Files
When exporting lookup lists to comma separated files (.csv formatted) -- for use by Pendragon Forms Manager -- be
aware that for the following lookup lists, it is required that you first select which items you would like to export:
luClipMark
luContributor
luCoordSys
luLocation
luSpecies
luStrHabType
To add or edit the items selected for the above lookup tables choose "Select Items for Lookup Lists" from the
"Options" menu at the startup form.

Before a data entry session, or exporting of the above lookup lists, make sure that you recheck the above lookup list
selections to make sure that the selections are appropriate for the given data entry session or field survey outing.

Using the Multi-pick Selection Forms
For each of the above lookup lists there will be a multi-pick form which lets you decide which items to use in the
CMPASP desktop application's drop down lists, as well as which items to export into the .csv file format used by
Penddragon Forms Manager...and, pushed out to your PDA devices upon sync'ing. The below is an example using
the "Species" multi-pick selection form, but the principle is the same for the other multi-pick selection forms,
including the one used by the "luLengthRange" lookup table, accessed by way of the "Options" menu's "Age
Classes..."item, as well as the "Surveyors" multi-pick selection form accessed by way of the "Header" form's
"Surveyor" button.
The "Selected species from the 'luSpecies' Lookup table" form displays the species that are currently selected for
both export to the PDA application's "luSpecies" lookup table, and those same selections are used by the pick lists
which are components of the desktop CMPASP database application.

To change the selected items click on the above form's "Select/Deselect..." button.

From the mulit-pick selection form, i.e., the "Select species to use from the 'luSpecies' table" form in this case, you
can choose multiple species on the left and use the arrow buttons in the middle to move them over to the right
where the items become "selected." Use the same technique on the right pane to select and move items back to the
left side. Note that once an item has been clicked and highlighted then if you want to un-highlight the item it requires
clicking on that item a second time. To highlight/un-highlight this will need to be done for each item that you would
like selected/deselected. By closing the multi-pick selection form you complete the selection process and the new

list of selected species appears in the "Selected species from the 'luSpecies' Lookup table" form, and this is now the
current list of selected species that will appear in drop down lists and .csv export files.
The "Import" and "Export" Buttons
You can use the Import and Export buttons on the multi-pick forms to export and save your selections. Different
surveys may have their own unique pick list needs, e.g., in this example you might have the need for a different
species to appear on one specific field data collection outing versus another. If this is the case then the habit of
saving your selection files for each different situation will facilitate the process of switching between the different
selection groupings, and make it a much easier process to manage.
When you click on the "Export" button then you will be prompted to save the selection as a ".Selected" type file. In
the case of the luSpecies table it will be saved as the "luSpecies.Selected" file. You can rename the first part of the
file, but leave the ".Selected" text intact so that the Aquatic Surveys Program can find and import the file if needed.
When you click on the "Import" button then the program will look for ".Import" file types. If there are items in your
"*.Selected" file that are not in your "lu*" lookup table then those items will not be selected, i.e., only items found in
that given lookup table will be selected.

Managing Multiple Forms in Pendragon Forms Manager
There is an important consideration when maintaining non-uniquely named forms in Pendragon Forms® Manager. When the Aquatic Surveys
Program imports data from the Pendragon Forms® Manager it does this based on unique form name. There should be only one Pendragon
form named 'Header', and only one form named 'Individual', etc. If there is more than one form with the same name then the Aquatic Surveys
Program will import data from the topmost form only. If you must maintain multiple forms in Pendragon Forms® Manager with the same name
then you can hide the form from the Aquatic Surveys Program's import utility by changing the form's 'Category' to 'Hidden', i.e., all forms in the
Hidden and Recycle categories are ignored by the import utility. The category of a form can be changed by going into the form's property dialog
box (Refer to your Pendragon Forms® Manager documentation for a more detailed explanation.).

Hiding Fields on the PDA
The Pendragon Forms® *.pff files distributed with the program are designed specifically to be used with the Aquatic Surveys
Program. It is highly recommended that Individual projects modify the appearance of the forms to fit their data needs. This
however DOES NOT mean altering the structure of the tables underlying the forms, e.g. adding or deleting fields. Altering the
underlying structure will cause the Aquatic Surveys Program’s import utility to explode. Modifying the way the form appears on
the PDA does not alter the underlying structure of the PDA tables. By modifying the appearance of a form, you are simply
"hiding" fields that are not required by your survey, defaulting fields that cannot be defaulted in the Aquatic Surveys Program’s
default, or adding additional quality assurance procedures to the Pendragon form via defining ranges of numeric data, or via
scripting more complex QA/QC algorithms. In fact Pendragon Forms® is quite flexible and the manual is quite good. Project
managers are encouraged to investigate the broad range of useful tools in Pendragon Forms®. The management of Pendragon
Forms® is not supported by the CDFW, but inclusion of these template forms does allow project biologists the freedom to use
electronic data entry and modify data form appearance, default fields, and data entry quality control options to fit individual
project needs.
To hide a field on the PDA:

•

Open Pendragon Foms® Manager.

•

Click on the form to be modified, e.g, Header, Individual, Count, or Redd.

•

Click ‘Edit’ from the buttons on the left.

•

Use the selection hand or radio buttons to select the field you would like to hide.

•

In the "Data" tab, make sure that the field is not required.

•

In the visualize tab check the "No Focus" box.

•

In the "Sizing" tab simply move the slider for "Question Height" and "Answer Height" to the top (collapsed). See that in
the left pane the field has "disappeared". Although crew will no longer see the field when they are collecting data, in
actuality you simply hid the field on the PDA so surveyors will not enter, or need not scroll past, non-necessary fields,
making the PDA application more efficient to use.

Finalizing the PDA forms
When the application's forms and lookup lists have been imported, "frozen", and "distributed", then synchronize the
Pendragon Forms® Manager with the PDA to complete the setup. Note that if you have installed a previous version of *.pff
files then it is a good idea to delete any forms from your PDA device that are related to this application, i.e., give the device a
"fresh slate" before synchronizing.

Instructions for HotSync-ing, Importing, and Appending PDA Data
•

Connect PDA to upload cable or cradle.

•

Click "Home" on PDA.

•

Click "HotSync" Icon on PDA.

•

Click "HotSync Icon" (settings should be on Local and Cradle/Cable).

•

After the HotSync operation is complete and the cleaning up process is done, you will hear a series of high
pitched noises and see a message on both the PC and PDA.

•

Open Aquatic Surveys Program.

•

Select Contributor (whoever is hotsync-ing the PDA) in drop down list.

•

Select Defaults >(your project defaults) in drop down list.

•

Back at the application's start up form, click "Import" button.

•

With the "Pendragon Forms Manager 5.1 Database" option selected, click on the "Continue" button.

•

At the "Imported PDA Data: PDA_Header" form, click "Options" from the menu bar.

•

Select "Backup Pendragon Forms Manager", then choose OK. With this step, you just created a backup copy of
the "Forms32K.mdb" file and had it put it in the "...\Aquatic Surveys Program\PendragonBackups" folder.

•

Click "Options" button on task bar at top of screen.

•

Click "Import from Pendragon Forms Manager".

•

A dialog pops up.

•

If there is already any data in the table at this point click "Cancel" and skip to the append step, append the
existing data, then return to this Import step. If you see a blank table click "OK".

•

Click "OK" at second prompt that tells you the operation was successful. If you get an error message, See
the Troublshooting and Problem Solving section.

•

You should now see the "Imported Data: PDA_Header" table with your header information from the PDA
imported form Forms32K.mdb.

•

Click the "Options" menu on the menu bar.

•

Select "Append Imported Data to Database".

•

Select the "SurveyID" for the survey you are appending the data to. Note: This implies that you have already set
up a Survey for the data that you are going to append -- If not then review the Setting Up a new Survey in the
Aquatic Surveys Program section before proceeding.

•

Select the "Default Settings" you created for you survey.

•

Click "Append Data" and then ‘OK’.

•

Dialog box will appear ‘Imported data was successfully appended ....’
*If an error message appears refer to the Troubleshooting and Problem Solving section.

•

Click "OK" at prompt.

•

Now close the Header window. Congratulations -- You are done!

Importing from a Pendragon Backup

Besides importing PDA data from Pendragon Forms® Manager, you can also import PDA data from a backup created during an earl
Two things happen automatically when you click on "Import from Pendragon Forms® Manager"....

First, the Aquatic Surveys Program creates a backup of the "Forms32K.mdb" file which maintains the original raw electronic data, as
Program\PendragonBackups" folder and assigned a date-time stamped file name as in the example below:
"Backup102610144551_Forms32K.mdb.bkp"
...which, in the above example, indicates that the backup was created on October 26, 2010 at 2:45:51 PM.

Second, after the data is brought into the Aquatic Surveys Program, or imported, the data undergoes some reformatting to facilitate a
backed up and the time stamped file is placed in the "...\Aquatic Surveys Program\PendragonBackups" folder as well, with a naming
"PendragonImportedData_102610144551.mdb"

So, if something goes wrong during the import process, e.g., data is mistakenly deleted after the import, you can re-import from the P
original Forms32K.mdb file with data in the Backup*_Forms32K.mdb.bkp" file¹. The latter is a complicated process that you will likely
"Import from Pendragon Backup" item.

-¹The "*" or asterisk indicates a wild card, i.e., the date-time stamp part of the name in this c

The Pendragon Forms® *.pff files distributed with the program are
designed specifically to be used with the Aquatic Surveys Program. It is
highly recommended that Individual projects modify the appearance of
the forms to fit their data needs. This however DOES NOT mean altering
the structure of the tables underlying the forms, e.g. adding or deleting
fields. Altering the underlying structure will cause the Aquatic Surveys
Program’s import utility to explode. Modifying the way the form appears
on the PDA does not alter the underlying structure of the PDA tables. By
modifying the appearance of a form, you are simply "hiding" fields that
are not required by your survey, defaulting fields that cannot be defaulted
in the Aquatic Surveys Program’s default, or adding additional quality
assurance procedures to the Pendragon form via defining ranges of
numeric data, or via scripting more complex QA/QC algorithms. In fact

Pendragon Forms® is quite flexible and the manual is quite good. Project
managers are encouraged to investigate the broad range of useful tools
in Pendragon Forms®. The management of Pendragon Forms® is not
supported by the CDFW, but inclusion of these template forms does
allow project biologists the freedom to use electronic data entry and
modify data form appearance, default fields, and data entry quality
control options to fit individual project needs.
To hide a field on the PDA:

•

Open Pendragon Foms® Manager.

•

Click on the form to be modified, e.g, Header, Individual, Count,
or Redd.

•

Click ‘Edit’ from the buttons on the left.

•

Use the selection hand or radio buttons to select the field you
would like to hide.

•

In the "Data" tab, make sure that the field is not required.

•

In the visualize tab check the "No Focus" box.

•

In the "Sizing" tab simply move the slider for "Question Height"
and "Answer Height" to the top (collapsed). See that in the left
pane the field has "disappeared". Although crew will no longer
see the field when they are collecting data, in actuality you
simply hid the field on the PDA so surveyors will not enter, or
need not scroll past, non-necessary fields, making the PDA
application more efficient to use.

Using the Desktop Database Application for Data Entry
Change Table Links Utility
Most of the time the Aquatic Surveys Program automatically links to its tables in the backend database at
startup. However, with the migration to Windows 7 came more security and restrictions regarding how we use
our MS Access database files, and how much the operating system is going to trust database files that are
external to the one that we currently have open. To this new environment there will have to be some
workarounds in order for the Aquatic Surveys Program to complete tasks that we require of it, like attaching
tables from one database file to another. Earlier versions of the Aquatic Surveys Program have always come
with a "Relink Tables" utility that in the past has worked quite well to relink tables that have lost a connection or
were relocated, orphaning them from the frontend database. This tool is still located under the "Options" menu,
view-able while at the program's startup form.

Under the new environment this tool no longer works consistently, and the problem may require a little more
"force". As of version 0.7.5 of the Aquatic Surveys Program there is a new tool, under the "Options" menu,
named "Change Table Links". If the frontend database is having issues trying to find and/or relink to the backend database then give this utility a try.

Entering from Paper Data Forms into the Aquatic Surveys Program
•

From the Aquatic Surveys Program start up screen, click the "Enter" Button.

•

Click the "Select" button to select the Survey that you wish to enter data into. The record will be
highlighted in green once selected.

•

Click the "Data" button. You will be sent to the data entry form.

•

At the bottom of the screen you will see a row of record navigation buttons.

•

Click the

•

In the grey section at the top click on the LocationID drop down list and select the location of your
data collection. This selection will populate the "GeoArea", "GeoUnit", and "LocationCode" fields
automatically.

•

Click the calendar button next to the ObsDate field and double click on the date of the data
collection.

•

Click the

button on the far left to enter a new Header record.

button to enter surveyors that collected the data. Use the arrow buttons to move the

surveyors to the right pane, then click.

•

Continue to select Weather, Air Temp, etc. where appropriate in the Header information.

•

Enter any text you would like that pertain to this Header data in the "Comments" box. You may now
enter data into the datasheets, i.e., "Individual", "Count", "Redd", "Snorkel", "E-Fish", and
"StreamHabitat" as well as the sub-datasheets, i.e., "Tag", "ClipMark", "Sample", and
"FishOnRedd", by clicking in the radio button(s).

•

Both the "Count" and "Redd" tables have no related sub-datasheets to them, but the Individual
table has related ‘Tag’, "ClipMark", "Sample", and "FishOnRedd" sub-datasheets. In other words,
an individual fish, e.g., may have one or many tags, have a clip or marks, and/or have been
observed on a redd, or multiple redds.

•

Enter the Individual information first, e.g., Species, ConditionCode, etc.

•

With the black arrow indicating you are in this individual record, select the sub-table you would like
to enter data, then click on the cross-hairs to the left of the Individual record. This will expand the
sub-datasheet to enter, e.g., the Tag table as in the below example. Enter one or many records
(Tags) that you observed on that fish, or applied to the fish.

• Once you have made your datasheet entries there is no need to save as data in MS Access
applications is saved automatically once entered.

• Continue this process of selecting the individual datasheet then make datasheet or sub-datasheet
entries as necessary.
• The navigation buttons at the bottom of the form will navigate you through the Header records
within the selected survey.

• The
button will delete the current Header record and ALL datasheet records associated with it.
Know what you are doing when you click on this button. You will be prompted to make sure you
would like to do this. It cannot be undone within the program. If this occurs accidentally, and you
used the PDA to collect the data, you can retrieve these data. See Import from Pendragon
Backup. If these data were taken on paper data forms, you will have to re-enter the data again.

Age Classes and Length Ranges
This section will help you better understand both the "luAgeClass" and "luLengthRange" lookup tables.

luAgeClass Lookup Table
The above table is not downloaded as part of the set of other lookup tables that you will find online and
within the Survey Management lookup table database, i.e., it will not be found in the drop down list at the
Survey Management Switchboard site. Since there are so few items in this lookup table, and the list of age
classes is not very likely to change, this lookup table resides solely in the back-end Aquatic Surveys
Program database. If you do need to add an age class record for your project it will have to be done there;
however, the standard list of age classes that come with the Aquatic Surveys Program setup includes the
following:
0
1+
2+
3+
That is all that you really need to know about this lookup table other than it is used to populate the
"AgeClass" field in various other tables.

luLengthRange Lookup Table
The luLengthRange lookup table has a somewhat more complicated purpose. First, it can be found, edited,
and downloaded by way of the Survey Management web application. It is where standardized codes are
maintained for defining discreet length-range categories. These codes are used wherever there is a need to
group fish within a given size range, e.g., for biological purposes such as age class studies or regulatory
uses like catch size requirements. Used in conjunction with the luAgeClass lookup table, an "Age Class
Structure" can be defined for a variety species over different time periods.
There are four fields in this lookup table that require some explanation....
First, the "SortCode" field is simply used to sort the list of length-range codes as they appear in your drop
down lists; in other words, the order that these drop down list items sort is up to you.
The second field is the "RangeCode". These values may appear merely descriptive, e.g., "<12 IN. FL" for
less than 12 inches fork length, but they are also unique codes that can be used as a primary key; as such,
they should never be modified once put into use and referenced by the data.
The third is "Expression"; as the name implies, this value is a mathematical expression, i.e., one that will be
use by Aquatic Surveys Program built-in queries. Because these values are used in mathematical
calculations, it is important that they are formatted correctly. Below are some examples:
>=12
The above represents greater than or equal to 12.
<8
The above represents less than 8.
>=8 And <12
The above represents greater than or equal to 8 and less than 12.
If the three example expression values above were compiled as 3 separate records in the luLengthRange
lookup table, and were used to indicate the length ranges of a single species then all possible lengths could
be accounted for in the database when the data is queried for counts per species for a given size range,
i.e., by species of interest all counted or sampled fish would be parsed between the above three lengthrange groups.
For the purpose of the Expression value it is not necessary to worry about the measurement units as this is
handled by project level metadata and the "LengthUnit" field in the various tables that utilize the
luLengthRange lookup table.
And last, the "Description" field is for a brief but meaningful definition of what the code actually represents in
plain English.

Assigning Length Ranges to an Age Class
Overview
In addition to the "luLengthRange" and "luAgeClass" tables, there is also the "luAgeClassStructure" lookup
table. Like the luAgeClass table, this lookup table is not part of the set of lookup tables that you will find
online by way of the Survey Management lookup table database. This is a local table only, and maintained in
the Aquatic Surveys Program back-end database, and it is to be used specifically for that database; in other
words, this table is configured with values that represent the age class structure needs of a particular project,

and it does not provide a universal list like the other Aquatic Surveys Program lookup tables, therefore, it
should be considered part of a single project's unique dataset.
The purpose of the luAgeClassStructure lookup table is to provide an automated method for changing the
association between a group of fish, based on species and length, and an age class. Without an automated
way of doing this then each record, in each table that utilizes the "AgeClass" parameter, would have to be
individually evaluated and edited should the AgeClass parameter need to be updated, taking a significant
amount of time, and introducing the possibility of human error. With the use of the luAgeClassStructure table,
we can edit just one record for a given species and age class, i.e., update the length-range code for a given
luAgeClassStructure record, and we a basically done.
When the luAgeClassStructure table has been populated with all of the information relevant to species,
length-range, and age class for a given project or survey effort, then (1) access this utility by clicking on the
"Aquatic Surveys" form's "Details" button. At the "Survey Details Record" form select the "Update AgeClass
Values for this Survey" option. This will run a procedure that will update all of the AgeClass values for the
given survey.

Populating the luAgeClassStructure Lookup Table
Prior to populating the luAgeClassStructure lookup table you must first make sure that the luLengthRange
table is populated with the appropriate information in the online Survey Management lookup table database,
accessed from the "Survey Management Switchboard" pick list of lookup tables. This lookup table will have
been imported with the rest of the lookup tables during the Aquatic Surveys Program setup or update
process. If any of the length-ranges have been edited or added to since the setup then download the list
again, and re-import it. After importing, list items in your local luLengthRange lookup table will need to be
selected using the "Select Items from luLengthRange Lookup Table" multi-pick form, accessed by way of the
startup forms "Options" menu's "Age Classes..." item.
Also accessible from the above mentioned Options menu under the "Age Classes..." item is the "Assign
AgeClass Length Ranges" submenu item.

The above form is self-explanatory for the most part....Species and values selected from Select Items from
luLengthRange Lookup Table multi-pick form can be matched-up with an AgeClass value to populate the
form. The form is bound to the luAgeClassStructure lookup table, and when populated or updated then the
procedure outlined above can be used to update all of the AgeClass field values in the database on a per
"Survey" table record basis.

Using the Program's Filter Utility
Filtering occurs only at the "Survey" level so first you must select a Survey record then click on the "Data"
button which gets you to the "Header" form. From the Header form chose "Filter Header Records for
Selected Survey" from the "Options" menu. This will bring up the below popup form.

Filtering allows you to restrict records, navigable by the Header form, to only those that meet "EnteredBy",
"Surveyor", "From Date", "To Date", "GeoArea", "GeoUnit", and "LocationCode" criteria. GeoArea is autopopulating based on the selected Survey’s GeoArea, but if you leave any one of the other fields blank then
those parameters will not be included in the filter criteria. The EnteredBy and Surveyor drop down lists only
include those persons that pertain to the data for the selected survey, i.e., if the person was not involved in

the selected survey then he/she will not show up in the drop down lists. Dates default to the start and end
survey dates, and attempting to filter for data outside that date range will not provide any filtered data as a
result. The rest is more or less self-explanatory.... When you want to remove the filter then select "Remove
Header Filter" from the Options menu.

Finding a Specific Record
The Aquatic Surveys Program provides for three different methods of finding specific records, i.e., two that are
custom to the application itself and one that draws upon MS® Access's built-in functionality. Let's go over the
later first.
If you have done much with Microsoft Office products then you are aware of it's "Find and Replace" dialog box.
This functionality can be used when at the Aquatic Surveys Program’s "Header" form by selecting "Find
Record" from the "Options" menu. Since you can find lots of information about how to use this dialog box from
Microsoft Help, we won't add any additional instructions here other than to say that it does not work on
Accesses' "Replication ID" fields, i.e., GUID values such as the form's "HeaderID" and "LocationID" fields.

If you would like to search on any one of the Aquatic Surveys Program’s Replication ID fields then access the
"Find by Replication Identifier..." form by way of clicking on the Options menu at the "Aquatic Surveys" form.

It is fairly self-explanatory from there. The third way you can search for specific records is by way of the "Find
by ReddCode..." form. It can be accessed as described above except click on "Find by ReddCode" at the
Options menu this time.

It also is fairly self-explanatory.... Basically, you select an option; provide a "RedCode" value to search for; click
the "Find" button, and away you go...to the record you are looking for...

Running Data Validation Rules
•
•
•
•

From the Aquatic Surveys Program start up screen select "Enter".
Using the button, Select the survey you wish to run with the "Data Rules" checking utility.
In the "Options" tab, select "Generate a 'Data Rules' Validation Report for this Survey". It really doesn't
take that long, unless you have a lot of data. Next, click "OK".
If your data capture is way better than mine, you will get a dialog that says that "...you have no
errors". Likely, a report will pop up indicating what data validation rules are broken and where the
offending record can be found.

Data Validation Rules Setup
Built into the protocol of Gallgher and Knechtle (2005) for CMP Spawning Surveys, are some logical
associations that must agree for the data to have been collected correctly. Algorithms to check that these
"associations" are correct have been built into the Aquatic Surveys Program and are called "Data Validation
Rules". Running these rules is one of the processes to QA/QC the data that has been collected and
entered. The following steps set up these Data Validation Rules for your survey.

•
•
•
•
•

From the Aquatic Surveys Program start up screen click the "Options" menu and select "Defaults".
Using the radio buttons at the bottom of the entry screen, navigate to the Defaults "ID" you set up
earlier.
Click the "Optional Data Rules" button. This opens the Optional Data Rules table
Click in the "RuleNo" field and select RuleNo "1". In the "Description" field you will see a brief
description of the rule that you are applying.
In the next row select RuleNo "2". Continue this process through RuleNo "5". We highly
recommend using all rules to QA/QC your spawning survey data.

Using Waypoints instead of Coordinates
The Aquatic Surveys Program let’s you choose between using coordinates or waypoints. The disadvantage
to using coordinates is that you must transcribe entire coordinates from the GPS unit into the Pendragon
Forms® form¹. Needless to say, this opens up the data to a greater degree of human error than simply
entering succinct, character waypoint identifiers (please see "Important Note about Waypoint Naming
Conventions" section below); waypoint identifiers can be text up to 10 characters for that matter. The
disadvantage to using waypoints is that there are extra steps to the data import process.
If you would like to try the waypoint data entry method here is how to proceed:
First, the GPS files will be in the form of the .GPX format. Which is a sort of XML data format. To import this
into the Aquatic Surveys Program you will need to get it into a comma separated value format with the
following fields...

The "ident" field has a max of 10 characters; all other text fields are a maximum of 255 characters, and the
numeric fields are all double (floating decimal). That being said, the only fields that require values are the
"ident", "lat", and "long" fields. Preferably, the lat and long fields are in the GPS’s default format which is not
projected (spherical) and WGS84 datum. A typical waypoint file converted to comma separated values
would look like the one below.
type,ident,latitude,longitude,y_proj,x_proj,comment,ltime
WAYPOINT,TTT2,41.166183,-120.313438,41.166183,-120.313438, ,2011/10/02 04:52:52
WAYPOINT,CAMP,41.454977,-120.264261,41.454977,-120.264261, ,2011/10/02 16:37:49
The real issue though becomes getting the .GPX format into the comma separated value format that the
Aquatic Surveys Program can recognize. To do this we recommend the DNR Garmin GPS Application.
The DNR Garmin GPS Application was developed by the Minnesota Department of Natural Resources and
is free. It has been immensely useful to our group in managing GPS data, i.e., migrating it from GPS to
ArcGIS® as well as GoogleEarth®. You can find installation and start-up information at their website;
however, we have developed a basic User's Guide to make getting setup with the DNR Garmin GPS
Application even easier -- unfortunately, this guide is somewhat out dated now, i.e., it explains use of older
GPS units downloading to a 32-bit system (Windows XP OS). If you are using a relatively newer GPS unit
and/or running the 64-bit version (Windows 7) of DNR Garmin then refer to the more comprehensive,
online DNRGPS 6.0 documentation published by the Minnesota Department of Natural Resources...in
particular, review the "File" section for how to save in the GPX format, and also take a look at the Appendix
1 - Data Manipulation --> GPS File Structures and requirements --> Waypoints section for information on
waypoint file structure.
Once installed...

•

Connect the GPS unit to the PC, and turn it on.

•

Open the DNR Garmin GPS Application.

•

Select "General Properties" from the "File" menu.

•

Select the "Waypoint" tab.

•

Make sure that only the first seven items are checked, i.e., type, "ident", "lat", "long", "x_proj",
"y_proj", and "comment".

•

Click on the 'OK' button.

•

Select "Download" from the "Waypoint" menu, and the coordinates should begin to download².

•

With the coordinates downloaded, now select "Save as" from the "File" menu.

•

For the "Save as type" select "Text File (Comma delimited)(*.txt)" then name and save the file.

•

With the Aquatic Surveys Program open, and at the start up form, click on the "Import" button.

•

At the datasheet that opens, select "Manage Waypoints" from the "Options" menu then select
"Import waypoints from comma delimited text file..."

•

Now, select the waypoint text file that you created, and click on the "Open" button.

This completes the process, and you have replaced anything that was previously in your
"imported_luWaypoint" lookup table with the new waypoint information. Until you change or delete the
contents of this table then information in it will be used to convert waypoint identifiers in your imported PDA
data to actual coordinates – this step is an automated routine that you can initiate by selecting "Update
imported PDA coords using current waypoints" from the "Manage Waypoints" sub-menu. To access
information in this table again, select "View current imported waypoints" from the "Manage Waypoints" submenu. You can use this datasheet to view, edit, and delete waypoint records.
Important Note about Waypoint Naming Conventions
When you create a waypoint on most GPS units, the unit will automatically assign a numeric name to the
waypoint, i.e., '00n + 1', preceded by zeros to create a name consisting of at least three text characters; for
example, on a device with no previously created waypoints, and after having already created two waypoints
by simply pressing the GPS’s 'MARK' button, you should have two waypoints named, '001' and '002',
respectively; when a third waypoint is created, and automatically named by the unit, it will be '003'. In the
aforementioned example, there would be an issue when using the Aquatic Surveys Program to reference
these waypoints and convert them to their longitude-latitude equivalents. This is because when the comma
delimited waypoint file gets imported to MS Access®, MS Access® will assume that they are numeric
values and convert them to 1, 2, and 3, respectively; however, in your data imported from the PDA device,
they are always considered text, i.e., they will remain in the '001', '002’, and '003' format and be recognized
as text strings consisting of three characters. Now, if on the other hand, you had renamed even one of the
waypoints, providing it with a true character in the name, e.g., '001', '002’, and 'WP3', then Access would
have sustained all three waypoint names as a text values, and imported them as is, preceding zeros and
all. This headache can be avoided by adopting the protocol of not accepting the automatic name your GPS
unit assigns newly marked waypoints, and preceding any numbers with text, e.g., 'WP1', 'WP2’, and 'WP3'.
Better yet, give your waypoints short names that are self-documenting, i.e., a person could infer by the
naming convention where the waypoint was taken. An example of how this might look is below:
Name
SMSBR
RCCLJ
CCB
MBSC

Description
Somes Bar
Red Cap Creek Log Jam
Camp Creek Barrier
Mouth of Bark Shanty Creek

¹The current version of the Pendragon Forms® GPS Control, unfortunately, is not supported by Meazura
Palm/Garnet OS PDA devices; however, adding this control to a future version of the Aquatic Surveys
Program is a possibility, i.e., when enough users own PDA devices that can benefit from the addition of this
control which will be able to read the GPS signal by way of Bluetooth or a cable connection.
²If you have a newer GPS unit then the above step may not hold true as the DNR Garmin GPS Application
may not have been updated since your GPS unit was manufactured. Fortunately, there is a workaround.
The newer units will be recognized by your PC as an external memory device, like flash memory. If this is
the case then you can you can select "Load From" from the GPS unit’s "File" menu then select "File", and

navigate to the folder on the GPS device that contains the .GPX file, e.g., "F:\Garmin\GPX\Current\". Once
there, select "GPS eExchange Format (*.gpx)" from the "Files of Type" list, and select the waypoint file to
import into the DNR Garmin GPS Application. The file will have been automatically given a name by the
GPS unit, something like "Current.gpx", or, if they are saved waypoints it may have a file name like
"Waypoints_17-SEP-11.gpx". You will need to check with the manual for your particular GPS unit to
become familiar with your unit's specific waypoint saving conventions.

Backing-up Data
As a rule, if on any regular basis you are entering data into the Aquatic Surveys Program, or importing data
into it from a PDA, then you should backup that data at least every day. The importance of this cannot be
stressed enough. If your computer crashes, and you loose data then you will very quickly understand why it
is so important. Also, it is best if the backup is to an external hardrive device, i.e,. not somewhere on the
same computer that might crash. Preferably, you have two or more external backup devices, e.g., a Lacie
USB connected external hard drive (about $100 each), and you keep one of those drives offsite, i.e., not in
the same building that may burn down, flood, or where a theft could occur, as unlikely as that may seem.
This may be overkill, but if you have ever experienced major data loss before then you know already how
stressful this is so just try to avoid it in the first place. If you do not have a large volume external hard drive,
or in addition too one of those devices, you can also use flash memory (thumb) devices as the Aquatic
Surveys Program database -- if compacted regularly -- should be well under the data volume limit of most
portable memory devices.
A typical backup program of choice is SyncBack software, because it works well, is easy to use, and it's
free. Here is the link:
http://www.2brightsparks.com/syncback/
After downloading and installing SyncBack, do not be put off by all of the functionality that comes with this
software. You only need to create a simple backup profile that copies files from one place to another. The
caveat with this program is that it does overwrite older files with newer files so if you want to have a
combination of daily backups, bi-weekly backups, weekly backups, etc. (highly recommended) then you will
have to create separate profiles for each of these scenarios. Just set the profiles up so that the different
automated backup profiles save to distinctly different file folders so you are not overwriting a weekly backup
with a daily backup, etc.
Automatic Pendragon Forms® Backups
At the import data screen, accessed by way of the "Import" button then selecting from the "Options" menu
and choosing the "Import from Pendragon Forms® Manager" option, ...after importing data from the
Pendragon Forms® Manager, note that in the MS Access® application’s project folder, i.e., the folder where
the data entry application is maintained, there will be a sub folder named "PendragonBackups". The "Import
from Pendragon Forms® Manager" procedure automatically places a date-time stamped backup database
inside it each time an import occurs, e.g., a backup database with the name:
"PendragonImportedData_081308135605.mdb"
...indicates that the backup was made on August 13, 2008 at 1:56:05 PM; this backup will have autopopulated fields as indicated by the "PendragonForms" table configuration information, but otherwise data
will be the same as the data in the Pendragon Forms® Manager prior to the Pendragon Forms® import
procedure making any modifications for compatibility with the Access application database. In addition,
another backup will have been created using an exact copy of the Forms32K.mdb file, i.e., the Pendragon
Forms Manager database, prior to the import procedure being executed.
Importing from Automatic Pendragon Forms® Backups
The "Import from Pendragon Backup" procedure allows for importing from an automatic backup database,
rather that from the Pendragon Forms® Manager database. Run this in the same way you would the
"Import from Pendragon Forms Manager" procedure, but instead choose the "Import from Pendragon
Backup" option.

Packaging Data

The term "packaging data" as it relates to the Aquatic Surveys Program simply means getting the data out
of your database and into another separate database. This is a survey by survey process. In other words,
you can only package one survey at a time, and each "package" contains only one survey.
Packaging data has four purposes: first, it is a way of archiving off your data; second, it frees up memory
in your database so you can begin entering new data (MS Access® databases have a size limitation of 2
GB); third, it provides you with a discrete "package" of data that can be submitted for inclusion into a
central data store; fourth, since the Aquatic Surveys Program maintains data for only one project, and
perhaps one, maybe two, season's worth of raw data at a time, it is entirely possible that the lookup tables
maintained by these project level databases may only have a subset of what is in the Survey Management
web application's lookup table database...If, for example, different locations are used from one season to
another, and older, no longer used, locations are removed from the project level (local) "luLocation" lookup
table then there could be a data integrity problem; this is because the Aquatic Surveys Program is a
relational database, and lookup table records must be present in the project's local database (the Aquatic
Surveys Program's .mdb file) for each data record that references that lookup item...so if referenced lookup
table records are removed from the project, or local, database file then any raw data, or "Surveys"
referencing those lookup table items must be removed (archived) from the database first. This is best
accomplished by packaging the data before importing an updated lookup table from the Survey
Management web application. If this is not done first then referential integrity rules, built into the Aquatic
Surveys Program, will require that the data without proper lookup table references be deleted; you would be
warned by a message box before record deletion were to occur, but it is a good idea to be prepared for how
to handle this at the beginning of each new season.
This fourth reason to package data is discussed in more detail in the "Updating the Back-end
Database" section.
The data packaging utility can be accessed by way of the "Package" button.

At the "Select Surveys for Data Packaging" form, select a survey, and click on the "Continue" button.

...after packaging a survey by way of the "Select Surveys for Data Packaging" form, note that in the MS
Access® application’s project folder, i.e., the folder where the data entry application is maintained, there will
be a sub folder named "Packages". The "Select Surveys for Data Packaging" procedure automatically
creates this folder and places a date-time stamped database package file in it using a file naming
convention similar to the one used below:
"AquaticSurveysDataPackage_102610144551.mdb"
...which indicates that the package was created on October 26, 2010 at 2:45:51 PM; this package file will
have all relevant data tables and all data for the selected survey. This includes the "Version" table which
maintains information about the particular database design version that the package was created from.
The rest is self-explanatory for the most part. If you are packaging the data for submission to a central data
store, it is important that you maintain some level of organization when carrying out this process: first, make
sure you have arranged for someone to receive and append your data to the central data store; second,
set up a repository system with that person so submitted data packages go to a secure site for processing;
third, make backup copies and keep track of your data packaging history to head-off the possibility of lost or
misplaced data; and fourth, make a backup copy of your back-end database before generating the data
package(s) -- this will allow you to "roll-back" to the previous state of your database should the need occur.

Importing from a Data Package
Importing from a data package lets you restore data to your database that was previously exported to a
data package.
1. Click on the "Package" button.

2. Chose the "Another 'Aquatic Surveys Program Database'" option.

3. Click on the "Continue" button...The rest should be self-explanatory.
There is a caveat to this process that is important to keep in mind. As mentioned in the "Packaging Data"
section, your data relates to items in several different lookup tables, information such as locations and
contributors. If you import data from an archived data package then make sure that you have the necessary
items in your lookup tables that relate to the imported data. For example, since last year maybe you have
removed a location from your local "luLocation" table, but last year you referenced that location item in your
data (which has since been archived off into a data package). You will need to add that location item back
to your local luLocation table prior to importing the data from last year’s archive package in order to comply
with data integrity rules built into the Aquatic Surveys Program. This would result in data without proper
lookup table references not being imported, i.e., not all of the packaged data would get imported or
restored.
This will rarely be an issue with more mature projects, but if you have been using the Aquatic Surveys
Program with candidate project data, and non-standard locations, i.e., not part of the established sample
frame then this could be an issue. If you are unsure then please get help from Technical Support before
restoring archived or packaged data.
Another issue is importing data to your database that comes from packages created by other projects.
Before doing this be aware that you will need the same lookup table information that is used or referenced
by the other project, e.g., locations, contributors, species, etc. In this case, it would be better to maintain a
separate database (that’s not your project’s data) for just such a purpose.

Importing Data from .CSV Format
The Aquatic Surveys Program supports importing data that not only originates from Pendragon PDA and
Cloud sources, but also from other sources if that .CSV data has been formatted appropriately. This can be
especially useful if your project maintains its own database solution, and if in your case it is preferable to
reformat that data into the ASP data model format so that data can be shared across a broad landscape.

For information on how to format your data into .CSV files and bring it into an ASP database, you can find
more details in the ReadMe file that comes with the setup files, titled "INSTRUCTIONS FOR IMPORTING
.CSV FORMATTED DATA (NOT ORIGINATING FROM THE PENDRAGONFORMS® CLOUD
APPLICATION)".

Also, take a look at the step-by-step instructions and screen shots from the Part VI Power Point Training
Slides with link titled "Aquatic Surveys Program Training -- Power Point Presentations".

Reviewing the above Power Point Presentation might be helpful even though your .CSV files are not
originating from the Pendragon Cloud platform. As you will learn, much of the .CSV import process is the
same whether using the Pendragon Cloud .CSV exports or whether those export files were the result of
your reformatting data from a non-ASP database.

Using the 'Refine Data to Append' Utility
The purpose of this utility or tool is to allow you to import multiple surveys worth of data but then only
append a subset of that data, i.e., just the selected surveys that you want to append to the back-end
database. The reason that you might need this tool is for cases where the .csv files maintain all of your data
as an external source or backup.
With the PDA paradigm you would simply synchronized data, and then import it...once that was
accomplished the original source data was automatically deleted -- not so with the Pendragon Cloud
paradigm and the use of .csv files. With uploading data from the mobile device to the Pendragon Cloud you
are now in the situation where you have the choice of leaving some or all of your data in the Cloud, only
downloading every so often and appending that data to your local Access back-end database. In some
cases you may want to do as before, downloading data as you collect it then deleting it from the source;
however, it is anticipated that for a variety of reasons, which we won't go into here, you very likely could just
leave much of the data in the Cloud for a time being. There are native Pendragon filter tools which allow
downloading only portions of the data, but those are geared more towards data by time periods whereas
ASP data is compartmentalized more by surveys than date and time so being able to select which surveys
you want to import/append makes more sense from an ASP perspective.
For example, let's say that you submit your data from the mobile device (to the Pendragon Cloud) daily, but
only once or twice a week you want the data back out and into your local Access database. The situation
which arises here is that you may have already imported/appended a Pendragon Cloud data download to
your local Access back-end database. Each time you download your data from the Pendragon Cloud you
simply download everything, but you are only interested in appending data from a particular survey, likely
just from the most recent survey. This is where the "Refine Data to Append" tool comes in handy.
To append data from just a subset of the surveys in your import data, at the "Import Data:.." table view
screen and after importing multiple surveys worth of data, access the Add-ins --> Options --> "Refine Data
to Append" menu item...

Click on the "Refine Data to Append" menu item.

...to remove (from the PRE-APPEND tables) all surveys except for those that you want to append from.

Separate surveys that you want to append with commas.
With SurveyIDs to append from provided, clicking on the form's OK button will remove all other surveys
(including data in related sub-tables) from the "PRE-APPEND..." tables.

Updating the Back-end Database
The Aquatic Surveys Program consists of two MS Access® databases, i.e., "frontend" and "back-end"
database files. The frontend refers to the part of the database application that you see and interact with,
i.e., forms, reports, code modules, supporting tables, etc. The back-end refers to the database file that
maintains only the data. The reason for separating the data from the functionality is mainly for convenience
of maintenance and performing ongoing version updates. Typically, the back-end file will have fewer
maintenance needs, and those needs will be related to database design changes which should be
infrequent once the initial development of the database has stabilized. On the other hand, the frontend
database may undergo frequent changes as functionality is continually added. For this reason it is a good
idea to keep the two separate as part of a development strategy. In addition, with the back-end separate,
updates to the design can be done in place, i.e., with an update utility you can make the changes yourself,
at a time of your choosing, with minimal disruption of the data entry process -- the alternative would be a
frequent process of appending data, i.e., each time new functionality was added. Another benefit of
separating the frontend from the back-end is that you can centrally locate the back-end database on a
secured computer and have multiple frontends on different computers network to it (provided your IT
administrators give you permissions to do so), allowing for data entry to the same database, via multiple
people on separate computers, with almost no loss of computing speed. The back-end database can also
be "swaped-out", i.e., editing multiple back-end databases with the same frontend.
When a new version of the Aquatic Surveys Program is made available, it will be accompanied by an

update utility if there have been design changes, i.e., table and field structure has been modified. The
update utility is for the back-end database only as your current version’s frontend database will get
swapped-out by the new version -- that’s why it is important that any custom queries or database objects,
you create, get added the back-end database only; the back-end database can be considered your project's
personal database that will never get swapped-out with a newer one, only updated in-place.
The update utility, if one does accompany release of a new version, will have its own documentation for
how to run the update so there will be only minimal mention made on this website of that process. However,
below are things you should know before updating your back-end database file:
Most every lookup table in the back-end database has referential integrity with the data tables. This means
that before a field in a data table, which draws its values from a lookup table, can maintain a particular
lookup value, that item must exist in the related lookup table. The purpose of this is a database construct
that forces correct entry of data. In the long-run it's a good thing, but can be an inconvenience at the field
database level. Normally, you would not encounter any problems with this forced relationship between the
lookup and data tables, but a potential data loss situation can occur when lookup tables are updated, and it
is important to be aware of it before importing a fresh set of lookup tables that you have downloaded from
the Survey Management Switchboard site. More is said about this in the "Updating the Aquatic Surveys
Program with New Lookup Tables" section.
The situation is this -- when you deactivate a lookup table item that you may have used in seasons past,
e.g., associate a "luLocation" a "ProjID" value to "-2" (inactive project location) to the lookup item, then that
item will be removed from your local lookup table. If there was data associated with that lookup item which
has now been removed then any previous season’s data in the current database could also be removed as
well, i.e., data records deleted to maintain referential integrity. This is particularly true with the 'luLocation'
and 'luContributor' tables. In most cases, once you have added lookup items to a lookup table, for your
given project, you will continue to use those items season after season, but, for example, sample-frame
locations could change from one season to the next, and if this is the case then you must be especially
wary before importing fresh lookup tables.
To illustrate this, let's say you deactivated a couple of locations (reaches) this season, and added a few
new ones. The new ones aren't a problem as they will automatically get added to your luLocation lookup
table upon importing the new lookups; however, if the couple of locations that you deactivated have data
associated with them in your current database then those data records will get deleted by way of forced
referential integrity (...with a message box warning first...always cancel if you are not sure what to do!). To
prevent this you must package or archive any back-end data that utilizes those removed luLocation lookup
items prior to importing the fresh lookups; please see the section on "Packaging Data" for more discussion
on this subject.

Preparing your Database for an Update
The previous section talks about updating the back-end database after a new version of the Aquatic Surveys Program has
been made available, i.e., one that has design changes. There are basically two critical things you must remember to do
before performing any design updates on your back-end database, and a third, optional, task. (1) Make sure that you have
sync'ed all data from ALL of your project's PDA's, and imported the data into the Aquatic Surveys Program (see the section
on "Instructions for HotSync-ing, Importing, and Appending PDA Data"). (2) Make a backup of your "Aquatic Surveys
Data.mdb" file ( see the "Backing-up Data" section).
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -(3) There is also a third preparation task that is optional, but performing it could very likely save you troubles down the road.
The issue is that when MS Access® imports tables from another database – something that will definitely happen when you
upgrade – it by default makes some [incorrect] assumptions about the tables that you are importing. By default MS
Access® has a setting that automatically adds secondary indexes on fields based on their name. Unfortunately, this can
create additional problems.
MS Access® automatically adds a secondary index to fields that begin or end with these names:

•
•
•

id
key
code

•

num

Since the Aquatic Surveys Program has a number of fields that end with the letters “ID” and “Code” ...this can be a real
problem resulting in slowing down your database and in some cases preventing data from being appended when these fields
are automatically given a secondary index by MS Access's® auto indexing feature.

It is a good idea to turn off this auto feature before attempting to update your back-end database. To do this, open the backend database, i.e., "Aquatic Surveys Data.mdb", and from the "Tools" menu click on "Options". When the “Options” form
displays click on the "Tables/Queries" tab and remove any text in the field labeled "AutoIndex on Import/Create". The field
should be completely blank as it is in the screen shot below.*

Additionally, you should remove any secondary indexes from your data tables that may have been assigned automatically.
The following are your "data" tables:
ClipMark, Count, Efish, FishOnRedd, Header, Individual, Metadata, Redd, Sample, Snorkel, StreamHabitat, Survey, S
urveyMetadata, Surveyor, Tag
With the back-end database open, i.e., the "Aquatic Surveys Data.mdb", begin with the first data table listed above, and work
your way through all of them. First, open the table in design mode...

...then click on the indexes tool bar item...

...for each of the data tables compare the indexes with those in the screen shots below. If they are not identical then go
ahead and delete indexes not appearing in screen shots below for each respective data table:
ClipMark

Above are the only indexes that should appear for the "ClipMark" data table. Remove all others and save the table design.

Count

Above are the only indexes that should appear for the "Count" data table. Remove all others and save the table design.
Efish

Above are the only indexes that should appear for the "Efish" data table. Remove all others and save the table design.
FishOnRedd

Above are the only indexes that should appear for the "FishOnRedd" data table. Remove all others and save the table
design.
Header

Above are the only indexes that should appear for the "Header" data table. Remove all others and save the table design.
Individual

Above are the only indexes that should appear for the "Individual" data table. Remove all others and save the table design.

Metadata

Above are the only indexes that should appear for the "Metadata" data table. Remove all others and save the table design.
Redd

Above are the only indexes that should appear for the "Redd" data table. Remove all others and save the table design.
Sample

Above are the only indexes that should appear for the "Sample" data table. Remove all others and save the table design.
Snorkel

Above are the only indexes that should appear for the "Snorkel" data table. Remove all others and save the table design.
StreamHabitat

Above are the only indexes that should appear for the "StreamHabitat" data table. Remove all others and save the table
design.

Survey

Above are the only indexes that should appear for the "Survey" data table. Remove all others and save the table design.
SurveyMetadata

Above are the only indexes that should appear for the "SurveyMetadata" data table. Remove all others and save the table
design.
Surveyor

Above are the only indexes that should appear for the "Surveyor" data table. Remove all others and save the table design.
Tag

Above are the only indexes that should appear for the "Tag" data table. Remove all others and save the table design.
So, you can see from the above screen shots that your data tables should have no more than two indexes. One of them will
be the primary key field and the other (if there is a second index) is your only secondary index and its properties are set to
"Unique". If you are uncomfortable with making these sorts of modifications to your database then contact Technical
Support for assistance.
*For MS Access® versions later than 2003, this option is under "Access Options" --> "Object Designers".

Known Issues and Solutions
Version 0.9.16 Issues
Version 0.9.16 was missing the most recent versions of the Pendragon Cloud forms...'refGeoUnit' and 'refLocationCode' -Version 0.9.16a updates those two mobile device forms used in the location field's cascading lookup lists. For most this will not
be an issue, because nearly all CDFW users get their Pendragon updates by cloning the master copy of forms and not from the
.pff files in the zip package
Version 0.9.15 Issues
Version 0.9.15 had a small bug that was problematic for Prendragon Cloud app users, i.e., if a lookup list was exported where
there were no actual items in the list then the list option reminder records would not be generated leaving users to guess at
which options boxes are to be checked for the imported .CSV file -- Version 0.9.16 fixes that.
Version 0.9.14 Issues
With version 0.9.15 there where no changes to the ASP Desktop application so unless you are using the ASP Pendragon
Cloud application (forms) then there is no reason to upgrade from this version to version 0.9.15.
However, if you are using the ASP Pendragon® Cloud forms then see bullets below for some important changes.
ASP Cloud App Sub-version 63 to 64

•
•

Updated sub-version label in Survey form's section-type field to 64.
Replaced Header.Completed form field script to have named reference to the ObsCompleted field as original script
referenced ordinal position of the field.

•

Modified all GPS control scripts to use decimal degrees rather than degrees minutes seconds...had to modify Desktop
ASP App to only remove W and N rather than make the conversion.

Version 0.9.13 Issues:

•

Discovered after some use and testing, the method used for importing Pendragon® Cloud CSV data files was flawed.
Since these CSV files were structured in a third party proprietary way (something the ASP developer has no control
over), a whole new module of code needed to be added to the ASP to essentially clean and reformat the CSV imports
from the Pendragon® Cloud exports. In addition, we made some changes to the ASP Pendragon® Cloud application
(sub-version 63) to allow better CSV formatting of GPS data.

Version 0.9.12 Issues:

•

This version had a single bug that had apparently been around for a while but only recently became an issue.
Although, under most circumstances this bug was not a problem, it is considered critical so you should go with the
newer version of the program as soon as possible.

Version 0.9.11 Issues:

•

This version had a couple of issues with the import from Pendragon® Cloud .CSV routine. The fix for this was to
check for the presence of .CSV files that have no data in them and deal with this situation appropriately. The other fix
was to assume that if the Survey.csv file was missing data then the program should simply ignore it and assume that
all data is from the same Survey (same as if the Survey.csv was missing all together)

Version 0.9.10 Issues:

•

This version had a minor bug that prevented updating of coordinates from imported waypoint data.

Version 0.9.9 Issues:

•

This version was bug free but was missing a critical utility useful for dealing with downloaded Pendragon® Cloud .csv
files, i.e., the "Extract and Rename the Pendragon .CSV Files" menu item which was added in version 0.9.10. This
tool extracts from a .zip container, creates a import sub folder in the project directory, moves the files .csv files there,
and renames the .csv files.

Version 0.9.8 Issues:

•

This version had a bug which was around for a long time, but did not present a problem until after the ASP was
upgraded to MS Access® 2016 -- The result was an Error #5 message box when trying to go from the Surveys form
to the Header form. Oddly, this bug did not appear during many rounds of testing version 0.9.8. It was easily fixed
once identified.

Version 0.9.7 Issues:
Version 0.9.7 was for the most part bug and issue free. Primarily the changes made and implemented in version 0.9.8 were to
allow for compatibility with the Cloud version of Pendragon Forms. Two additions in particular made this possible:

•
•

(1) The .CSV lookup table export utility was modified to meet the Pendragon® Cloud import specifications;
(2) Additionally, an import feature was added that works with .CSV files exported from the Pendgragon Cloud platform
(this import feature also works with other sources of .CSV data not originating from the Pendragon® Cloud platform.

•

One of the more obvious changes was the renaming of the "PDA_*" tables to the "PRE-APPEND_*" tables. This was
to make it clearer that these tables accommodate not just imported PDA data, but data from multiple sources, and the
"PRE-APPEND" prefix is a better indication to users that the data has yet to be added to the regular data tables.

•

Version 0.9.7 was the last MS Access® XP (2002/2003) compatible version of the Aquatic Surveys Program, i.e., that
supported .MDB files. All future versions will be in the .ACCDB MS Access® format.

Version 0.9.6 Issues:

•
•

Resolved bug that caused issues if there were more than one Survey records selected in the 'Surveys' form.
When importing lookups from .xls files that have been exported from the .xlsx format, import error tables are created.
Code was added to remove these temporary tables prior to the next import.

•
•

Updated Help and Survey Management web links.
Fixed a bug related to record searches.

Version 0.9.5 Issues:

•

Up through this version some of the VBA comments regarding conversion of the program from Acceess 2002 to
Access 2010 were still not correct, particularly regarding use of the .xlsx file extentions rather that the older .xls Excel
format no longer used with the Access 2010 converted program. There were a few other minutia issues that were
fixed.

Version 0.9.4 Issues:

•

After clicking on the 'Continue' button in order to access the PDA import form, the 'Import Options'
form would remain displayed in popup form mode.

Version 0.9.3 Issues:

•

Up through version 0.9.3 the dialog box information for issues encountered during importing of
lookup tables was limited and options where not all that clear. Since version 0.9.3 improvements to

the lookup table import process were made so that users get better information from the dialog
message that appears and more options when dealing with “rouge” lookup items.

•

The table relink routines used, up through version 0.9.3, do not work when the databases are
converted to versions of MS Access® later than 2002. Since version 0.9.3 some of the table relink
code was removed to facilitate the process of converting the program from its 2002 version to later
versions of MS Access®.

Version 0.9.2 Issues:

•

If there were edits pending on the Header form then the program would not allow saving of any
edits that were made using the "More Header Fields" popup form.

Version 0.9.1 Issues:

•

All MS Access® versions of the CMPASP up till this point, i.e., through version 0.9.1, have lacked
the ability to easily convert from their older database types to MS Access® 2010 databases. After
version 0.9.1 this process will be made much easier by coding changes and other modifications.

Version 0.9.0 Issues:

•

With this initial 0.9 version there was an issue when importing from Pendragon Forms® Manager,
or even a backup, the data was being imported and backups were getting created, but the imported
data was not populating the PDA tables. The problem was with the new “Completed” field added to
the Header table, i.e., the “PDA_Header” table (the one that first intercepts your data from the
PDA) had the Completed field set as “required” ...this was a mistake as that field should be
optional. This was fixed in version 0.9.1. Another solution is to go into the frontend and change this
field in the PDA_Header table. Simply change the Completed field to not required then the problem
goes away.

Version 0.8 Issues:

•

This first MS Access® 2010 version had a few minor issues that did not appear in the initial testing,
e.g., backing up to *.mdb file format rather than *.accdb. These were fixed in version 0.8.1.

Version 0.7.6 Issues:

•

There was just one known issue with version 0.7.6, i.e., for the PDA application the ConditionCode
lookup list was not set to 'Exlusive' so users could type in their own value which should not be the
case. This has been fixed in version 0.8 -- In addition, many enhancements have been made in
version 0.8 so that the program can better accommodate a wide range of survey types, beyond the
original intent of the program -- which was originally only to accommodate spawner surveys..

Version 0.7.5 Issues:

•

With this version of the program which runs under MS Access® 2002, enhancements have been
made in order for the program to run more smoothly when setup on a computer with the new
CDFW IT modernization configuration, however there were still a few more enhancement that were
needed to facilitate the transition to the IT modernized environment; this was remedied in version
0.7.6. Additionally, pertaining to the PDA version of the application, the Surveyor form had an
improperly typed SurveyorPK field which would cause problems during importation of data from
Pendragon Forms Manager.

Version 0.7.4 Issues:

•

This version of the program runs under MS Access® 2002; enhancements have been made in later
0.7x versions to run more smoothly with the new CDFW image; it will not run properly with Access
2010, even if upgraded. In version 0.8 several modifications where made in order for MS Access

2010 compatibility, with the default 32-bit installation. In addition, a feature was added to allow the
importing of survey data from other CMPASP back-end databases so long as their version
numbers agree.
Version 0.7.3 Issues:

•

Since this version a bug was found in the Header Filter utility which incorrectly limited the items
appearing in the "GeoUnit" drop down list. This has been fixed. Also, the way that users can import
from the Pendragon Forms® manager has been restricted somewhat, i.e., now, if the PDA tables
contain data that has yet to be appended to the master database tables then attempts to import
from the Pendragon Forms® Manager will be prevented.

Version 0.7.2 Issues:

•

Data rule #4 was not specific to the selected survey, but compared ReddCode's against all surveys
in the database. This bug has apparently been around since at least version 0.6.

Version 0.7.1 Issues:

•

The packaging utility had some flaws that needed to be corrected, i.e., 1) the packaging routine
should have allowed packaging of only one survey's worth of data per FDC protocol, and, 2) the
routine needed to be updated to deal with multiple foreign key relationships that are now part of the
ClipMark table's configuration. (posted 2/1/12)

Version 0.7 Issues:

•

The update utility does not create the necessary relationship between the ClipMark.CountID and
the Count.CountID fields. This is not a real issue as it does not affect the program, and will be
corrected by the next design version update. Also, it only pertains to back-end databases that are
getting the update. The new database that comes with the installation has the above mentioned
relationship created. (posted 12/30/11)
Solution -- You can create the relationship yourself, or don't worry about it as there is no affect to
the data. The relationship simply provides for better data integrity, but likely will never be a real
issue.

•

For the "Individual" PDA form that gets created when importing from the "ndividual.pff"
Pendragon Forms® file, the "Exclusive" box should be checked but is not. This could be a problem
as not just any hand written code will work in this field. (posted 12/30/11)
Solution -- The "Individual.pff" file that comes with version 0.7.1 fixes this.

•

In version 0.7, code has been added which is supposed to clean-up unneeded luLocationLink
records, i.e., removes the ones that are not associated with the selected project locations. This is a
real problem, because it removes some of the desired luLocationLink records, resulting in an
incomplete location drop down list on the Header form.
Solution -- The "CMP Aquatic Survey Program.mdb" database file, that comes with the 0.7.1
version, fixes this by simply reverting back to the pre-0.7 code procedure which leaves all imported
records in the luLocationLink lookup table. Simple replace your version 0.7 "CMP Aquatic Survey
Program.mdb" database file with the one that comes with version 0.7.1. (posted 12/30/11)

